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16.0 Release 

Lecture 1  
Introduction to ANSYS Workbench 
 
 

Introduction to ANSYS Mechanical 
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Welcome! 

Welcome to the ANSYS Mechanical application introductory training course. 

This training course covers the basics of using ANSYS Mechanical  
in performing structural and thermal analyses. 

It is intended for all new or occasional ANSYS Mechanical users, regardless  
of the CAD software used. 

Course Objectives: 

– General understanding of the user interface, as related to geometry import, meshing,  
application of loads and supports, and postprocessing 

– Procedure for performing FEA simulations, including linear static, modal, and harmonic  
structural analyses and nonlinear steady-state thermal analyses 

– Utilizing parameters for ‘what-if’ scenarios 

 

• Training Courses are also available covering the use of other Workbench modules  
(e.g. DesignModeler, Design Exploration, etc.) . 
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Agenda (Day 1) 
Morning  Lecture – Introduction 

   Lecture – Chapter 2: Mechanical Basics 

   Workshop 2.1 

   Lecture – Chapter 3: General Preprocessing 

   Workshop 3.1 

   Lecture – Chapter 3, continued 

Afternoon  Workshop 3.2 

   Lecture – Chapter 3, continued 

   Workshop 3.3 or Workshop 3.4 

   Lecture – Chapter 4: Meshing in Mechanical 

   Workshop 4.1 

   Lecture – Chapter 4 (continued) 

   Workshop 4.2 

   Lecture – Chapter 5: Modeling Connections 

   Workshop 5.1 
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Agenda (Day 2) 

Morning  Lecture – Chapter 5 (continued) 

   Workshop 5.2 

   Lecture – Chapter 6: Remote Boundary Conditions 

   Workshop 6.1 

   Lecture – Chapter 6 (continued) 

   Workshop 6.2 

   Lecture – Chapter 7: Static Structural Analysis 

   Workshop 7.1 

Afternoon  Lecture – Chapter 7 (continued) 

   Workshop 7.2 

   Lecture – Chapter 8: Modal Analysis 

   Workshop 8.1 

   Lecture – Chapter 9: Thermal Analysis 

   Workshop 9.1 
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Agenda (Day 3) 

Morning  Lecture – Chapter 10: Multistep Analysis 

   Workshop 10.1  

   Lecture – Chapter 11: Results and Postprocessing 

   Workshop 11.1 

Afternoon  Lecture – Chapter 12: CAD and Parameters 

   Workshop 12.1 

   Choice of Appendix Chapters or discussion of user issues*  

 

  

* This course has been designed to run to just over 2.5 days to allow the last afternoon to be more informal.   There is 
a choice of Appendix Chapters  that explore different analysis types or go into some subjects in more depth.   If time 
allows user problems can also be discussed depending on the number of attendees. 
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Lecture 1: Contents 

 

A. About ANSYS Inc. 

B. ANSYS Customer Portal 

C. ANSYS Workbench Overview 

D. Demonstration 

E. Summary 

F. Overview of Mechanical 

G. APPENDIX 
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A: About ANSYS Inc. 

FOCUSED 
This is all we do. 

Leading product technologies in all physics areas 

Largest development team focused on simulation 

 

DEDICATED 2,700+  

75  

40  

employees 

locations 

countries 

MARKET LEADER 
Long-term growth, 

financial stability and 

CAD agnostic 

PROVEN 
 

Validating our solutions on the 

most advanced product 

applications 

40+ years 
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Breadth of Technologies 

Structural Mechanics: 
From Linear Statics    

Fluid Mechanics:  
From Single-Phase Flows   

Electromagnetics: From 
Low-Frequency Windings
  

Systems: 
From Data Sharing 

To High-Speed Impact 

To Multiphase 
Combustion 

To High-Frequency 
Field Analysis 

To Multi-Domain 
System Analysis 
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The ANSYS Customer Portal 

Contains over 85,000 support assets powered by a modern web user 
interface and powerful search engine. 
 

Over 5.2 million page views in 2014 
 
 

Support Products Downloads 
Knowledge 
Resources 

Classroom Training 
Webinars 
Service Requests 

Product Assets Latest Release 
Updates 
Tools 
Previous Release(s) 
Extension Library (App 

Store) 

Solutions 
Conference Proceedings 
Class3 Reports 
Documentation 
Training & Tutorials 

https://support.ansys.com 
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About search 

The ANSYS Customer Portal’s search is powered by 
dedicated Google® hardware. 

Mesh = Meshed = Meshing 
Export = Exported = Exporting 
XXXXX = YYYYY = ZZZZZ 

Example: 
You want a meshing tutorial for ANSYS Meshing and your search has 
results for other products that are not of interest to you; by selecting the 
product facet “ANSYS Meshing” you can narrow down your results further. 

Search Facets 
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Support / downloads / training 

Submit and review service requests 
 

If you cannot find the answer to your question within the ANSYS Customer Portal then you 
can submit a service request.  A member of ANSYS technical support will then get back to 
you with advice or a solution. 

Download the latest software and updates 
 

Download ISO images if you wish to create a DVD which is recommend for installations on 
multiple computers and allows you to keep an archive of the installation for later re-use. 
 

Package downloads can also be selected if you want to install files directly. 

Download classroom and video training material 
 

Training and tutorial material are available for both a broad range of ANSYS products and 
user’s experience. Search the hundreds of courses available and improve your knowledge 
of ANSYS software. 
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C. ANSYS Workbench 

 ANSYS Workbench is a project-management tool.  It can be considered as the top-level interface 
linking all our software tools. 

 Workbench handles the passing of data between ANSYS Geometry / Mesh / Solver / 
Postprocessing tools.   

 This greatly helps project management.  You do not need worry about the individual files on disk 
(geometry, mesh etc).  Graphically, you can see at-a-glance how a project has been built. 

 Because Workbench can manage the 
individual applications AND pass data 
between them, it is easy to automatically 
perform design studies (parametric 
analyses) for design optimisation. 
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D. Demonstration 

Demonstration : 01_WB_Presentation.mp4 
 

• What you can learn in this demonstration : 

 

– How to use Workbench project page 

– How to save, open, archive a project 

– How to create different analysis 

– Understand each stage of an analysis 

– Edit units, properties and files options 

– Working with parameters 
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E: Summary 

ANSYS Workbench is a convenient way of managing your simulation projects. 

 

Workbench is used to launch the individual software components, and used to transfer data 
between them. 

 

It is easy to see at-a-glace how a model has been built, and determine which files were used for 
a particular simulation (pairing geometry files to solver runs) 

 

Workbench also makes it straightforward to perform parametric analyses  (without the user 
needing to manually launch each application in turn), and makes it easy to simulate multi-
physics scenarios like fluid-structure interaction. 
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F. Mechanical Overview 

Analysis types available in Workbench - Mechanical:† 

• Structural (static and transient): 

– Linear and nonlinear structural analyses. 

• Dynamics:  

– modal, harmonic, response spectrum, random vibration, flexible and rigid dynamics. 

• Heat Transfer (steady state and transient): 

– Solve for temperature field and heat flux.  Temperature-dependent conductivity, convection, 
radiation and materials allowed.  

• Magnetostatic: 

– Perform various magnetic field analyses. 

• Electrical: 

– Simulate electrical devices such as motors, solenoids, etc.. 

† Note, the active ANSYS license dictates what functionality is available to the user.  Not all features listed are covered in this 

Introductory course. 
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 … Mechanical Overview 

Add-on licenses for Mechanical: 

• Rigid Dynamics 

• Fatigue Module 

• ACP 
 

16.0 Workbench products are available for Windows and Linux operating systems.   

• Check the ANSYS web site or online documentation for the latest compatibilities. 

 

Network licensing capabilities are used for all ANSYS and ANSYS Workbench products. 
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G. APPENDIX 



18 © 2015 ANSYS, Inc. February 27, 2015 

. . . Workbench Overview 

The options visible in the 
left-hand column show all 
the products (systems) you 
have licenses for.   

TIP:  If this list appears 
empty, you have a problem 
with your licensing. 

“Analysis Systems” are ready-made 
stencils that include all the 
individual systems (applications) 
needed for common analyses  (for 
example Geometry + Mesh + Solver 
+ Post-Processor) 

“Component Systems” are the 
individual building-blocks for each 
stage of the analysis 

“Design Exploration” 
provides tools for 
optimising designs and 
understanding the 
parametric response. 
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. . . Basic Workflow 

Dragging an Analysis System onto 
the project desktop lays out a 
workflow, comprising all the steps 
needed for a typical analysis. 

 

Workflow is from top to bottom.  
As each stage is complete, the icon 
at the right-hand side changes 
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. . . Alternative Workflow 

However, an analysis could equally well be prepared by selecting the 
individual Component Systems that are needed for this analysis, and then 
linking them together with connectors. 
 
TIP:  There are two ways to create the connectors between the systems: 
1) Use the mouse to draw a line (eg A2 to B3, B4 to C4 etc) 
2) Or, simply drop the new system on the cell of the upstream one, and the 

link will be generated automatically. 
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. . . Cell States 

As each stage in the model-build is completed, the state of the 
cell changes. 

Status after creating Geometry in A3, 
not yet opened Mechanical in A4 

Status after model has solved 
waiting for post-processing 

Icon Meaning 

Up to Date 

Refresh required.  Upstream data has changed 

Update required.  Local data has changed 

Unfulfilled.  Upstream data does not exist 

Attention Required 

Solving 

Update Failed 

Update Interrupted 

Changes pending (was up-to-date, but upstream data has changed) 
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. . . Sharing Data between Different Solvers 

 Workbench can be used to transfer data between solvers.  In this 1-way FSI (fluid-structure-
interaction) example, we transfer the loads from a Fluent CFD simulation over to a Mechanical 
system to perform a stress analysis 

The square connector shows 
that the geometry created in 
cell A2 (CFD model) is being 
shared with cell B3 (FEA model).   

The round connector shows that the 
CFD results are being transferred as a 
Setup (input) condition to be used for 
FEA stress analysis. 
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. . . File Location on Disk 

 Should you need to identify the individual files on your disk for each stage of the project, these can 
be found by enabling View > Files.  The resulting table will cross-reference the directory and 
filename with the project cells. 

Filename 
Directory 
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. . . Use of Archive / Restore 

 The workbench project comprises many files and directories.  If you need to either archive 
the project, or bundle it to send to us for a Technical Support query, use the ‘Archive’ tool.  
This generates a single zipfile of the entire project. 

When archiving, you can choose whether 
to include the computed result files or not 
(omitting these may make it small enough 
to send by email) 

If you restore an archive you can choose 
where you save (and solve) the project.  
If you double click on a .wbpz file it will 
unpack the file to the location given by 
Tools>Options>Folder for Temporary 
Files  
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. . . Working With Parameters [1] 

Most Workbench applications will let 
you specify key quantities as a 
parameter (rather than a constant).   
This will be covered later. 

In this example: 

• When creating the geometry in 
DesignModeler, hole diameter is set to 
be an input parameter. 

• When reviewing the results, the 
maximum stress is set as an output 
parameter 

We could just have easily set up a CFD 
analysis, looking at different loading 
conditions and reporting the pressure 
drops. 
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. . . Working With Parameters [2] 

• Clicking on ‘Parameter Set’ lets us vary these parameters.   
• Four different geometric designs are being tested. 
• The whole process is automated.   Workbench will recursively:  

i. Create the geometry, based on the parameters in the table 
ii. Take this into Mechanical and remesh and solve and then the postprocessor 

• The user just needs to sit back and wait, and the matrix of experiments (each requiring several different applications 
to be launched in turn) is computed automatically.  

1]  Create new row in table 
with each design (in this 
case hole diameter) 

3]  The desired result 
(set up in Mechanical) 
is reported here 

2] Click here to 
compute all the designs 

4]  The ‘Exported’ 
option allows 
snapshots of each 
DP to be saved to a 
different project 
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… Starting Mechanical 

There are two methods of launching Workbench: 

• From the Windows start menu: 

 

 

 

 

 

 

• From the CAD system 
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The Units menu in Workbench: 

• Select from predefined unit systems. 

• Create custom unit systems. 

• Controls unit display for Engineering Data, Parameters and Charts. 

• Activate the Units System dialog to unit display preferences. 

Units can be displayed in 

the active Project system or 

as they were defined in their 

source (e.g. CAD system). 

. . . Working With Units 
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. . . Working With Units 

Create custom unit systems by duplicating existing systems then modifying. 

Custom unit systems can be exported and imported. 
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Workbench license control is handled through the user interface shown below, activated from the 
Workbench project page:“Tools > License Preferences . . . “ 

. . . License Preferences 
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. . . License Preferences 

The order of license preference is specified using the up/down arrows (first available is used). 

• The “Use License” column indicates desired licenses to use (0 = off, 1 = on). 

Workbench users can specify whether a single license is 
shared when multiple applications are open, or if each 
application accesses their own license. 


